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Introduction
About The Compose Utility
The Compose Utility is a Windows 3 program that helps users enter characters and 
symbols that do not appear on the keyboard.

This is a problem that arises frequently, especially for European users.  Even those who 
write in only one language find that they sometimes need to use European characters 
such as ñ or ß in names or quotations.  They may also wish to use the other symbols in 
the Windows character set, such the French quotes « » or the copyright sign ©.

The problem is more acute for those who write in more than one language, especially if 
they have a USA or UK keyboard.

These characters can be entered by their ANSI code, using the Alt key and the numeric 
keypad, but that is cumbersome, even if the ANSI table is kept close to hand.

In the old typewriter days, we could try to simulate special characters by superimposing 
two other characters.  A "c" and a comma would produce something like a french ç, and a 
"Y" and a "=" would produce a ¥.

The Compose Utility allows users to do something similar with a PC keyboard, except that 
The Compose Utility generates the actual character required instead of a simulation.

The Compose Utility installs a Windows keyboard filter.  While it is running, users can type 
a compose key, followed by a two character mnemonic.  The Compose Utility will then 
replace the two characters by the required Windows character.

The Compose Utility runs in the background and works with any application.  By default 
the right control key is the compose key.

With The Compose Utility, entering special characters is not only easy, it is addictive!  
Here are some examples;

<Compose>  < < forms « <Compose> a e forms æ
<Compose>  y = forms ¥ <Compose> E ' forms É
<Compose>  c o forms © <Compose> 1 4 forms ¼
<Compose>  s s forms ß <Compose>  : - forms ÷

The sequences are very easy to remember.  Non-keyboard characters can now be typed 
in effortlessly, without having to search for an ANSI character table.

Compose sequences are defined for all the ANSI characters. If you do not like them, you 
can change them or add alternatives.

The Compose Utility also allows characters from special character sets, such as Symbol or
Dingbats to be entered by clicking on a button matrix.

License Information
This is a shareware product.  You may use it for a period of thirty days, and if you like it, 
you must pay a small registration fee.  If you work for a company or organisation, you 
should ask the manager in charge of software purchasing to buy a multiple copy license.  
These are very heavily discounted.  Information explaining how to acquire a license is in 
an appendix to this guide.

If you can carry on using The Compose Utility without paying for it, nothing will happen.  



You will not live in fear of a knock on the door in the middle of the night.  Buying a licence 
is simply a way of thanking me for the time I spent in developing the product.

Since this product is shareware, it may be distributed free of charge to others who may 
wish to try it.  It must be distributed in its entirety, with all the documents and ancillary files.
It may not be sold or used to market any other product without the written permission of 
Anthony Porter.  Any person acquiring this product from a Bulletin Board must be made 
aware that it is shareware before they download it.

License numbers may not be distributed to third parties.

If this product is unsuitable for your needs, you may destroy it during the thirty day free trail
period.  If you have purchased a licensed copy directly, you may return it within thirty days 
for a refund.

Anthony Porter will not be responsible for any direct or indirect losses or damages which 
might result from using The Compose Utility.

About the author
The Compose Utility was written by Anthony Porter, a consultant living in Brussels, 
Belgium.  Anthony Porter specializes in object oriented design and programming.  The 
Compose Utility was written in object-oriented style using C++.



Installation

Windows Keyboard Driver
Before you install The Compose Utility, you should make sure that you have the correct 
Windows Keyboard driver installed.  All the characters on the keyboard, should generate 
identical characters in a Windows application, such as Notepad.  On European keyboards,
additional characters can be accessed by using the right Alt key.  These characters are 
usually engraved in the lower right corner on the top of certain keys, or they may appear 
on the front face of the key.  These characters should also appear in the Windows 
application.

If this test does not work, if different characters appear, or if the system beeps, you 
probably have the wrong keyboard driver installed.

PC systems are often equipped with a USA QWERTY or a French AZERTY keyboard, 
instead of the local equivalent, such as a Dutch QWERTY or a Belgian AZERTY.  In these 
cases, it often happens that the local keyboard driver is installed by mistake, since the 
Windows installation program will do so by default.  If you live in Belgium for instance, you 
might have a French keyboard and a Belgian keyboard driver installed.

Changing the Windows keyboard driver is simple, just follow these steps.  You will need to 
have the Windows 3 distribution disks at hand.

Open the Main window in Program Manager.

Run Control Panel.

Choose International

When the dialog box appears, select the correct keyboard driver from the 
keyboard list.

Click on OK or press <return>.

Control Panel will prompt you to enter the diskette containing the keyboard 
driver.

The driver will be installed.

There is no need to reboot or restart windows.

Installing The Compose Utility
There is an install utility which runs under Windows.  Use the Windows File Manager or a 
similar program to run it.  For example, if the distribution disk is in drive A:;

Open File Manager.

Type  <Ctrl>A or click on the A drive icon.

Type <return> or double-click on the root directory.

Select Install.exe and press <return> or double-click on Install.exe.

The installation dialog box will now appear.



Use the To list box to select the directory where you wish to install The 
Compose Utility.  By default this is the Windows directory, but you may prefer
to install The Compose Utility in a directory containing other utilities.

If you enter a directory name in the Subdirectory box, Install will create a new
directory for you.

If you would like to add The Compose Utility to Program Manager, use the 
combo box to select the group.  If you do not use Program Manager, leave 
blank

If you would like The Compose Utility to be loaded automatically whenever 
you start Windows, leave the check box checked.  Install will then add an 
entry in the [Load] section of your win.ini file.

If you have a license number, enter it into the edit box, otherwise leave the 
box blank.

When all the options have been set, click on the Install button.  The program 
will be installed and run.

There is no need to reboot or restart Windows.

If you do not have a license number, you will be gently reminded after a few weeks that 
you should register.  You may add a license number at any time using the About dialog 
box, in the File menu.

Running The Compose Utility
If The Compose Utility has not been loaded automatically when Windows started, it can be
run by double-clicking either on its icon in Program Manager, or on its file name in File 
Manager.

When The Compose Utility is running, its icon appears at the bottom of the screen, The 
label shows the current Compose key.  By default this is the right control key.

Entering characters
Icon Mode
You may leave The Compose Utility as an icon.  Special characters can now be entered 
into any Windows application.  Try starting Notepad and entering <right control down> 
<right control up> <a> <e>.  The æ ligature should appear.  There is no need to keep the 
<right control> key down while entering the other two characters.  Just press it and release
it and then type the two characters.  Try <right control> <1> <4>.

The full list of default compose sequences is in the appendix at the back.

Button Mode
If you open the The Compose Utility icon, a matrix of buttons appears.  Each button 
contains a character.  If you click on any of these buttons, the corresponding character 
appears in the last window that you used

If have a scalable-font generator such as Adobe Type Manager or Bitstream Facelift 
installed, the matrix may take a little while to appear the first time it is displayed.

Remember that once you click on a button, The Compose Utility has the focus, and not the
other application.  Any characters that you type on the keyboard will be sent to the other 



application, but the application's menu keys and accelerators will not be active.

If the characters do not appear, it is possible that you have inadvertently given the focus to
another application before clicking on the buttons.  For instance, if you click in your 
application, and then in Program Manager and only then on the character buttons, the 
characters will be sent to Program Manager.

The button grid will stay on top of all the other windows, so you can access it while you 
work in your application.

It is convenient to use <Alt><tab> to switch between your application and The Compose 
Utility.  You can then run your application full screen and use <Alt><tab> to "pop-up" the 
button matrix.

You can keep the Compose icon visible by selecting Icon on Top from the Options menu.

You can still use Compose sequences even when the matrix is displayed.

Button mode is useful for entering characters when you have forgotten the compose 
sequence, but it is especially useful for entering characters from special character sets 
such as Symbol or Dingbats.

Changing the button font
If you choose the Font menu in The Compose Utility, you will see a list of all the fonts 
installed in your system.  If you choose a font, the buttons will be displayed in that font.

This option is useful for entering characters from the Symbol character set, or any other 
font with a special character set.

Remember that you must also select the same font in your application, otherwise you will 
see characters from the standard ANSI set.  Some applications, such as Notepad, do not 
offer the possibility of changing character sets, and so you cannot use Symbol or other 
special character sets with these applications.

If you have a lot of fonts installed on your system, the menu will not show them all.  
Instead it will contain a more fonts option.  If you choose this option a font browser will 
appear, showing a sample of each font.

If you want to enter symbols using Word for Windows, you must first select the Symbol 
font, then enter the characters by clicking on the button matrix, and then reselect the 
original font.  Alternatively, you can first enter the characters, then select them, and then 
choose the Symbol font.  This may be easier, but the characters are only displayed 
correctly when the Symbol font has been chosen.

Configuring The Compose Utility
The button display
As well as changing the font displayed in the buttons, it is also possible to change the size 
of the buttons.  If you have a high resolution screen you may prefer larger buttons.  On the 
other hand, if you have a standard VGA or EGA video adapter, you might prefer to have 
smaller buttons.  The Size menu gives you three choices, Small, Normal and Big.  Note 
that this option has no effect if you have chosen a fixed size font, such as System.

By default, the buttons have the standard Windows 3D look.  If you choose the 2D Buttons
option in the Size menu, the button matrix will be smaller.   You might prefer this option if 



you use a standard VGA or EGA screen.

Changing the Compose Key
The default compose key is the right control key.  This leaves the left control key for normal
control functions.

If you do not like the default, you may choose any other key as the compose key.

To change the compose key select Key from the Options menu.  A dialog box will appear 
inviting you to enter the new key.

Enter the new key.  Combinations of Shift, Control and Alt are allowed.  For example, if 
you wish Control+Shift+ScrollLock to be the new key, press Control, Shift and ScrollLock 
together and then release them.  The dialog box will show the keys you have chosen in the
language of the keyboard driver.  If you make a mistake, just try again.

When you are satisfied, click on OK or press <return>.  Neither <return> nor <escape> 
may be chosen as the Compose key.  The new key will take effect immediately.

Changing the Compose sequences
It is possible to modify the default compose sequences.  To do this choose the Sequences 
option in the Options menu.  A dialog box will appear showing all the sequences currently 
defined.  This box also serves as a reference should you ever forget a sequence.

More than one sequence can be defined for the same character.  For instance the default 
sequences define both <n> <~> and <g> <n> for the Spanish ñ.

The two characters can be entered in either order.  Usually this is convenient, for example,
<~> <n> and <n> <~> both generate ñ.  It does mean that you cannot, for instance, define 
<e> <a> as a sequence, since <a> <e> is already defined as the æ character.

Adding a sequence
To add a sequence, enter the two characters of the sequence in the two boxes separated 
by a + sign.  Enter one character in each box.  Enter the replacement character in the third
box, to the right of the = sign.

How do you enter the replacement character?  You click in the third box and then click on 
the appropriate button in the button matrix.  The character in the third box is displayed in 
the current font.

After you have entered the characters in the three boxes, click on the Add button.

Deleting a sequence
To delete a sequence, select it in the list and click on the Delete button.

Confirming the changes
After having changed some sequences, click on the OK button to confirm them.  If you 
click on Cancel, or press <escape> the changes will be discarded.

Saving the current configuration
Normally, the current configuration is automatically saved in a file called COMPOSE.INI 
that is generated in the Windows directory.

If you change the default compose key or the default compose sequences you do not need



to take any special action to preserve those changes. They are kept in the COMPOSE.INI 
file.

If you wish however, you may store different configurations in different files.  You may wish 
to do this if different people use the same machine and they all have their own 
preferences.

Use the Save As option in the File menu to save the current configuration in a file.  The 
default extension is .CPS.

To read a configuration file, either use the Open option in the File menu or supply the file 
name as a command line parameter when The Compose Utility is started.  Command line 
parameters can be specified using the Properties option in the Program Manager File 
menu.

Restoring the default configuration
If the COMPOSE.INI file in the Windows directory is deleted, The Compose Utility will 
revert to the default configuration, unless a configuration file is specified.

Problem Solving
The Compose Utility does not work at all
The program might not have been installed properly.  Use the installation program.

Make sure that it is running.  The icon should be visible.  The icon label shows the current 
compose key.  Someone might have changed it.

The Compose Utility is compatible with all well-behaved Windows applications, but it is 
possible that you have an application or utility installed that interferes with The Compose 
Utility's operation.  You might be suspicious of other keyboard or macro utilities.  Try 
running The Compose Utility without them.

The Compose Utility does not work with a certain application
If The Compose Utility works with all applications except one, it is probably because that 
application is bypassing the standard Windows keyboard driver routines.  You might be 
able to enter the text into Notepad and then cut and paste it into the other application.  You
should report the problem to the authors of that application.

Instead of a special character Windows displays a bar | or a bullet .
Some characters are only available with the more recent fonts.  Double-click on the 
Compose icon to see which characters are available.

The special characters appear on screen but are not printed 
correctly.
Some printers cannot print the special characters when an internal font is used.  This is 
especially common with older dot-matrix printers.

Try using a Windows font such as Modern or Roman.  The characters will be sent to the 
printer in graphics mode.  This will be slower but will bypass the problem.

There may be a font card or cartridge available for your printer which supports the 
Windows ANSI character set.  It is also possible that there is a new version of the 
Windows driver for the printer which supports the complete character set.  

If you have a laser printer, you may need either a Windows font card, or additional 



memory.  Ask your dealer for advice.

If you still have problems.
If the technical staff in your organisation cannot help you, contact me for advice.  The 
address is inside the front cover.  A fax would be the most convenient, but you could also 
use CompuServe or try telephoning. I cannot help with printer problems.



Registering The Compose Utility
If you like The Compose Utility, you should buy a licence, if you have not already done so. 
If you work for a company or organisation, you should ask the person in charge of software
purchases to acquire a multiple licence.  The price of a license is as follows;

Number Belgian US Canadian Pounds 
of users Francs Dollars Dollars Sterling
1 500 15 17 8.50
2 - 5 400 per user 12 per user 13.50 per user 6.80 per user
6-14 350 per user 10.50 /user 12 per user 6.00 per user
25 5000 150 170 85
50 6500 195 220 110
100 8000 240 270 135
250 12000 360 400 200

Users having more than one workstation, for example, at home and at 
work, need only one license.

Belgian US Canadian Pounds 
Francs Dollars Dollars Sterling

Illustrated 100 3 3.40 1.70
user guide
Program 100 3 3.40 1.70
diskette 3½"

These prices include shipping of guides and diskettes by surface mail.  Licence numbers 
will be sent by fax, CompuServe or surface mail.  If you require a tax invoice, please state 
to where it should be sent.

Belgian customers should add 19½ % VAT.

You may pay by cheque.  Eurocheques should be made out in Belgian francs, other 
cheques in your local currency.  Cheques should be made payable to Anthony Porter.  
Youmay also transfer directly to the Belgian BBL bank account number 310-0706419-54.

You may also pay by Eurocard, MasterCard or Access in Belgian Francs.    Please 
mention the card holder's name, the card number and expiry date.
Sorry, Visa Belgium will not accept mail order operations at the moment.



Default Compose Sequences
These characters are available with any Windows font.

! ! = ¡ " " = ¨ ' ' = ´ ( ( = [ ( - = { ) ) = ]
) - = } + - = ± + _ = ± , , = ¸ - . = ¬ . . = ·
/ / = \ / \ = × : - = ÷ : : = | < < = « > > = »
? ? = ¿ _ _ = ¯ 1 1 = ¹ 1 2 = ½ 1 4 = ¼ 2 2 = ²
3 3 = ³ 3 4 = ¾ a " = ä A " = Ä a ' = á A ' = Á
a . = å A . = Å a ^ = â A ^ = Â a _ = ª a ` = à
A ` = À à à = À  a ~ = ã A ~ = Ã a e = æ A E = Æ
c , = ç C , = Ç ç ç = Ç c : = ¢ d - = ð D - = Ð
e " = ë E " = Ë e ' = é E ' = É é é = É e ^ = ê
E ^ = Ê e ` = è E ` = È è è = È g n = ñ G N = Ñ
i " = ï I " = Ï i ' = í I ' = Í i ^ = î I ^ = Î
I ` = ì I ` = Ì i j = ÿ l - = £ m u = µ n ~ = ñ
N ~ = Ñ o " = ö O " = Ö o ' = ó O ' = Ó o / = ø
O / = Ø o ^ = ô O ^ = Ô o _ = º o ` = ò O ` = Ò
o ~ = õ O ~ = Õ o c = © o o = ° o r = ® o x = ¤
p i = Þ P i = þ p p = ¶ s o = § s s = ß u " = ü
U " = Ü u ' = ú U ' = Ú u ^ = Û U ^ = Û u ` = ù
U ` = Ù y " = ÿ y ' = ý Y ' = Ý y = = ¥

The following characters are available with Adobe Type Manager V2.0 fonts and TrueType 
fonts

, ' = ‚  base right single quote f f = ƒ  florin
, " = „  base right double quote . , = …  ellipsis
| - = †  dagger i - = †  dagger
| = = ‡  double dagger i = = ‡  double dagger
^ ^ = ˆ  circumflex % % = ‰  per thousand
S " = Š  uppercase Scaron < ' = ‹  left angled quote
O E = Œ  o e ligature [ ' = ‘  upper left single quote
( ' = ‘ ] ' = ’  upper right single quote
) ' = ’ [ " = “  upper left double quote
( " = “   ] " = ”  upper right double quote
) " = ” # + = •  solid bullet
n - = –  en dash m - = —  em dash
~ ~ = ˜  tilde accent t m = ™  Trade Mark
T M = ™ s " = š  lower case scaron
> ' = ›  right angled bracket o e = œ  lower case oe ligature
Y " = Ÿ  uppercase Y diaresis


